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Notice

The software described in this document is furnished under a license agreement or nondisclosure
agreement. The software may be used in accordance with terms of the agreement. Every effort was
made to ensure that the information in this guide was complete and accurate at the time of printing.
However, information is subject to change.

Trademarks
PagePac is a registered trademark of HARRIS CORPORATION Dracon Division.

Support Telephone Numbers
AT&T provides a toll-free customer Helpline 24 hours a day. In the U.S,, call the AT&T Helpline at

1-800-628-2888 if you need assistance when installing, programming, or using your system. For

service or technical assistance in Canada, call one of the following Technical Assistance Centers:

Eastern Canada and Ottawa: 1-800-363-1882 o —

Ontario: 1-800-387-4268 ; i

Centra and Western Canada: 1-800-663-9817 ;

Software Version f

This guide is written for software release 1.51. {
§
i

INSERT DISK HOLDER HERE
VERSION AND TYPE




HARRIS CORPORATION, DRACON DIVISION
LICENSE AGREEMENT AND LIMITED PRODUCT WARRANTY

Harris Corporation provides the enclosed computer software program (“Program”) and licenses its use to you. Y ou are responsible for selecting the Program
to achieve your intended results and for the installation, use and results obtained from the Program.

THE PROGRAM, INCLUDING ITS STRUCTURE AND ORGANIZATION, ASWELL ASITS CODE, IS A PROPRIETARY PRODUCT OF HARRIS
CORPORATION AND IS PROTECTED BY COPYRIGHT LAWS. TITLE TO THE PROGRAM, AND ANY COPY, MODIFICATION OR MERGED
PORTION OF THE PROGRAM, SHALL AT ALL TIMES REMAIN WITH HARRIS CORPORATION.

LICENSE

YOU MAY:

Use the Program only on a single computer. The Program may be transferred to and used on any computer, but may not under any circumstances be used

on more than one computer at atime.

a. Use the Program only on a single computer. The Program may be transferred to and used on another computer, but may not under any circumstances be
used on more than one computer at atime.

b. Make one copy of the Program into any computer readable for backup or modfication purposes in support of your use of the Program on asingle
computer.

c. Transfer the Program together with this Agreement to another party, but only if the other party agrees to accept the terms and conditions of this
Agreement. If you transfer the Program and Agreement, you must at the same time either transfer any copy of the Program, permitted under b. above. to
the same party or destroy any copy not transferred. Any such transfer terminates your right to use the Program.

Y ou must reproduce and include the copyright notice on any copy, modification or portion of the Program merged into any other program.

YOU MAY NOT:

a TRANSFER OR RENT THE PROGRAM OR USE, COPY, MODIFY, OR MERGE THE PROGRAM IN WHOLE OR IN PART, EXCEPT AS
EXPRESSLY PERMITTED IN THIS AGREEMENT.

b. DECOMPILE, REVERSE ASSEMBLE OR OTHERWISE REVERSE ENGINEER THE PROGRAM.

¢. REPRODUCE, DISTRIBUTE OR REVISE THE PROGRAM DOCUMENTATION.

IF YOU DO ANY OF THE FOREGOING, YOUR RIGHT TO USE THE PROGRAM SHALL AUTOMATICALLY BE TERMINATED. SUCH
TERMINATION SHALL BE IN ADDITION TO AND NOT IN LIEU OF ANY CRIMINAL, CIVIL, OR OTHER REMEDY AVAILABLE TO HARRIS
CORPORATION.

LIMITED WARRANTY

EXCEPT AS PROVIDED BELOW: THE PROGRAM IS PROVIDED “AS1S” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR
IMPLIED, INCLUDING, BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE; THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM ISWITH YOU; IF THE PROGRAM PROVES
DEFECTIVE, YOU ASSUME THE ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

SOME STATES DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES, SO THE ABOVE EXCLUSION MAY NOT APPLY TO YOU.
THISWARRANTY GIVES YOU SPECIFIC LEGAL RIGHTSAND YOU MAY ALSO HAVE OTHER RIGHTS WHICH VARY FROM STATE TO

STATE.

Harris Corporation does not warrant that the functions contained in the Program will meet your requirements or that the operation of the Program will be
uninterrupted or error free.

Harris Corporation does warrant the diskette(s) on which the Program is furnished, to be free from defects in materials and workmanship under normal use
for a period of 90 days from the date of delivery to you as evidenced by a copy of your receipt.

LIMITATIONS OF REMEDIES

Harris Corporation’s entire liability and your exclusive remedy shall be:

1. the replacement of any diskette not meeting Harris Corporation’s “Limited Warranty” and which is returned to Harris Corporation with a copy of your
receipt.

2. if Harris Corporation is unable to deliver a replacement diskette which is free of defects in materials or workmanship, you may terminate this Agreement
by returning the Program and your money will be refunded.

IN NO EVENT WILL HARRIS CORPORATION BE LIABLE TO YOU FOR ANY DAMAGES, INCLUDING ANY LOST PROFITS, LOST SAVINGS
OR OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE SUCH PROGRAM EVEN IF
HARRIS CORPORATION HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, OR FOR ANY CLAIM BY ANY OTHER PARTY.

SOME STATES DO NOT ALLOW THE LIMITATION OR EXCLUSION OF LIABILITY FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES SO
THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU.

U.S. GOVERNMENT RESTRICTED RIGHTS
Should the Program be used in connection with a U.S. Government contract, the following provision shall apply:

The Program and documentation are provided with RESTRICTED RIGHTS. Use, duplication or disclosure by the U.S. Government is subject to
restrictions as set forth in subdivision b(3)(ii) of The Rightsin Technical Data and Computer Software clause of 252.227-7013 of the DOD FAR.
Contractor/manufacturer is Harris Corporation Dracon Division.

GENERAL

You may not sublicense, assign or transfer the Program except as expressly provided in this Agreement. Any attempt otherwise to sublicense, assign or
transfer any of the rights, duties or obligations hereunder is void.

This Agreement will be governed by the laws of the State of California
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About PC Programming of PagePac Plus

The PagePac Plus User Interface software package runs
on a generic DOS-based IBM PC or compatible. It
requires no more than 640K RAM and a single 3.5 inch
floppy-disk drive. The program operates in character
mode, and supports both monochrome (MDA or Hercules)
and color (CGA or above) displays and adapters. It uses
color if it is available and provides a high-contrast color
scheme for use on machines with Liquid Crystal Displays
(LCD). The Controller unit has the ability to retain the
configuration options indefinitely.

The PC connects to an RS-232 port on the rear of the
Controller by means of a crossover cable (also called a
null-modem cable).

Before you Begin Programming

1. Fill out Zone Map and Configuration Tables.

Paging zone decisions should be made and
diagramed prior to beginning programming. Refer to
the Zone Map and Zone Configuration tables in the
PagePac Plus Paging Controller Programming and
Operation Guide.

2. Set Zone Option Switches.

3. |If you are using the|Zone Mapping feature| (page 19),
you must determine the controller firmware Issue #
before programming. describes this
procedure.




The slide switch for each zone must be manually set
to one of the following options, depending on the
programmed mode selected for each zone:

« Contact Closure Output (to switch on/off a device,
such as a door security lock, remote amplifier, etc.)

» Contact Closure Input (such as doorbell or
security alarm interface)

« 70V Output for audio

3. Set Dip Switches.

If Zone Expansion Units are installed, the DIP switch
on each unit must be set prior to powering up the
system, and prior to programming. Refer to the
PagePac Plus Controller Installation and Use Guide,
or to the Zone Expansion Unit Installation and Use
Guide, for instructions.

Loading/Starting the Programming Software

1. Turnon PC.
Let it boot up. At the DOS prompt C:> on the screen:
2. Insert diskette.

Insert PagePac Plus User Interface diskette into disk drive
(A: or B:) and close the drive mechanism.

3. Type <drive letter>: [ENTER].

Type A: (or B:) and press [ENTER] to direct the DOS
system to the correct disk drive.

4. Type PPPLUS [ENTER].

The introductory screen will come up, displaying the
PagePac Plus startup screen.

The following command line switches listed can be used
after the execute name, i.e.,

PPPLUS /BW [ENTER]




Switch Description
/BW forces black & white display mode

selects serial port; also available via options
ICOMN - enu item (COM1-COM4)

sets zone map format; also available via config
NSSUEN || Map (ISSUEL or ISSUE2)
/? display program version number and options

5. Press any key to continue.

The screen will be blank except for the Menu Bar across
the top of the screen (visible in




Which File to Open?

If you want to make changes to the configuration that is
currently in use by the PagePac Plus system, perform step
1. If you want to use the original default configuration (or
another version that you have previously saved) to make
changes and then send to the Controller, go to step 2.

1. Change the current configuration.
a. Select Transfer from the Menu Bar.

b. Select Receive from the Transfer menu.

This will place a copy of the current configuration into the
PPPLUS program. You may make changes to it and then
use the Transfer/Send option to send your modified
configuration back to the Controller.

2. Use the default configuration (or another saved
version).

a. Select File from the Menu Bar.
b. Select the Load option from the File menu.

You will be prompted to enter the name of the file you wish

to load. If no name is entered, the default file will be loaded.
You may make changes to it and then use the
Transfer/Send option to send your modified configuration
back to the Controller.




Recommended Procedure

Follow this summary of steps to implement the
configuration changes you wish to make. Depending on
your needs, you may wish to go directly to the menu(s)
and table(s) that access the specific options you wish to
change. Detailed instructions for each step are provided
elsewhere in this guide.

1.

Load the configuration to be modified.
See ['Which File to Open’| above.

Make changes to System parameters.
See[‘System Parameters.”|

Make changes to individual Zone or Group
parameters.

See ['Zone/Group Parameters.”| Repeat this step for each
zone or group.

Define or change the make-up of a Zone Group.
See|“Zone Groups.”| Repeat this step for each group.
Make changes to Zone Mapping.

See [‘Zone Mapping.’]

Send your new configuration to the Controller.
See[‘Transfer Menu. |

Change Monitor or Log File setup.

See [“Options Menu.’|




About the Screen

Use Mouse or
Keyboard

ESC key

F1 HELP

Menu Bar

[ALT] +
Highlighted
letter

Use your keyboard or mouse to select from the menu bar,
and from all other menus in this program.

Mouse—put the cursor on the option you wish to select,
and click the left mouse button once, to select.

Keyboard—use arrow keys, or type first letter of the
option name, to move the cursor to the option. Then
press [ENTER] to select the option.

Press [ESC] (escape key) to get out of any menu and
return to the menu bar. The File Menu provides the Exit
option. Select Exit to get out of the programming software
and return to the DOS prompt.

Press [F1] for context-specific HELP at any point in any of
the tables.

The Menu Bar is always visible across the top of the

screen (see Use the keyboard or mouse to
activate a pull-down menu from the menu bar.

This pulls down a menu item from the menu bar




File Menu

NOTE: File Name
Prefix—A configuration
file name consists of a
prefix up to 8 characters
in length, followed by a
suffix (CFG). You
choose what you wish

to call a new file (the

prefix), and the

PPPLUS program will
automatically use the

CFG suffix.

The File menu allows you to create a new configuration,
load an existing one, or save the current configuration
(including any changes made) on disk. Use the arrow
keys to highlight your selection, then press [ENTER].
Press [ESC] to abort any of these options and return to
the Menu Bar.

1. Select New, Open, Save, or Exit.
New resets the current configuration to the factory
default values, discarding any changes previously
made.
Open loads configuration data from a disk file that
you have previously named and saved. You will be
prompted to Open a New File by entering a new file
name prefix.
Save a configuration file that you are asked to name.
You can save a new file that you create (by giving it a
new name prefix), or save changes to an existing file
(by saving it without changing the file name).
Exit takes you out of the programming software and
back to the DOS prompt.
Filev View® Config¥ Transferv Options¥ Monitorr Help
New Start a new configuration
Open | Open configuration file
Save | Save configuration to file
_ Exit | Exit to operationg system

Open a New File
Enter File Name Prefix (8 chars max) : PAGE-1

ESC to Abort

Figure 1. File Menu, Open Option




View Menu

The View menu enables you to view (but not alter) the
configuration that is currently loaded into the PagePac
Plus Controller. You can view the system parameters,
individual zone configurations, zone groupings, or the zone
mapping (the telephone extension numbers assigned to
zones and groups).

Each of these options brings up a table similar to the
tables under the Config Menu.

Select an Option, press [ENTER].
Options are:

System (View System Configurations)

Information (View System Information)

Zone/Group (View Zone/Group Configurations)

Groups (View Zone Groups)
Map (View Zone Mapping)

Filew

View® Config? Transfere

System View System Configuration
Information View System Information

System View

Connection Password
Programming Password
Configuration Tone
Pre-Announcement Tone
Talk-Back Warning Tone
Vox Disconnect Time
Remote Monitor
Attendant Access Monitor
Telephone Monitor

Night Bell Monitor
Supervised Trunk Mode
Zone Microphone

Inhibit Dial Tone Detect
Serial Port Bit Rate

~—— ESC to Abort

OptionsY¥

: ON

: ON

: REPEAT
: 30

: COMPUTER
: OFF

: OFF

: OFF

: OFF

: OFF

: OFF

1 9600

Monitor®  Help

Figure 2. View Menu, System Option




Config Menu

The Config menu selects the portion of the loaded
configuration to be edited. Each of these options brings
up a table where more specific options are to be selected

(see figure 3] below). Use the arrow key to highlight your
selection and press [ENTER] to select, or click the mouse

button on your selection.

Select an Option, press [ENTER].
Options are:
= System (System Parameters)

IZone/Group (Zone/Group Parameters)|

IGroups (Zone Groups)|
IMap (Zone Mapping)|

[Copy (Copy Configuration)|

System Parameters

System Parameters apply system-wide, and are not
zone-specific. Choosing this configuration option brings up
a table in which further options may be set. Press [F1] for
context-specific HELP. For further information about
system parameters, refer to the PagePac Plus Controller
Programming and Use Guide.

The following functions allow you to maneuver within the
tables.

= Use the Space Bar to toggle between options.
= Press [ENTER] to select a setting.

= Press [CTRL] plus [ENTER] to accept changes and
exit table.
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The arrow keys, <up, down> move the cursor within the
table. Use the space bar to toggle between ON and OFF
or to scroll through the options for each parameter. Then
press [ENTER] to select the option. When finished with
this menu, hold down the [CTRL] key while pressing
[ENTER] to accept the parameters and return to the
Menu Bar.

Filew Vieww Config? Transfer® Options® Monitore Help

System System parameters
Zone/Group | zZone/Group parameters

System Configuration

Current New
[
Programming Password :
Confirmation Tone : ON ON
Pre-Announcement Tone: ON ON
Talk-Back Warning Tone: REPEAT REPEAT
Vox Disconnect Time : 30 30
Remote Monitor : COMPUTER COMPUTER
Attend Access Monitor : OFF OFF
Telephone Monitor : OFF OFF
Night Bell Monitor : OFF OFF
Supervised Trunk Mode : OFF OFF
Zone Microphone . OFF OFF
Inhibit DTD . OFF OFF
Serial Port Bit Rate : 9600 9600

—Ctrl-Enter to Accept - ESC to Abort———

Figure 3. System Parameters Table

1. Connection Password—Type password (or leave
blank).

Enter a Connect password to restrict access to the
PagePac Plus paging system. A password can have up to
6 digits (characters are not allowed). Leave blank if no
password is desired. Press [ENTER] to set the password.
The default is no password (blank).




2. Programming Password—Type password (or leave
blank).

Leave blank if no password is desired. Type up to 6 digits
to set a programming password. (Characters are not
allowed.) Press [ENTER] to set the password. The default
is no password (blank).

3. Confirmation Tone—ON or OFF.

Use space bar to toggle between ON and OFF. Then
press [ENTER]. The default setting is ON.

4. Pre-Announcement Tone—ON or OFF.

Valid settings are OFF and ON. Use space bar to toggle,
then press [ENTER] to select. The default setting is ON.

5. Talk-back Warning Tone.

Valid settings are OFF, INITIAL, and REPEAT. Use space
bar to toggle through options, then press [ENTER] to select
one. The default setting is REPEAT.

6. VOX Disconnect Time.

Valid settings are 00 (none), 10 seconds, 20, 30, 40, 50,
and 60 seconds. Use space bar to toggle through options,
then press [ENTER] to select one. The default is 30
seconds.

7. Remote Monitor.

This parameter selects either the PC or a visual text display
device as the remote monitor connected to the PagePac
Plus Controller. Valid choices are COMPUTER and
DISPLAY. Use space bar to toggle between them, then
press [ENTER] to select. The default is COMPUTER.

8. Attend Access Monitor.

With this parameter you choose whether to monitor
Attendant Access paging activity. Use the space bar to
toggle between ON and OFF, then press [ENTER] to select.
The default is OFF.

11
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9.

10.

11.

12.

13.

14,

Telephone Monitor.

Choose whether to monitor Telephone Access paging
activity. Use the space bar to toggle between ON and OFF,
then press [ENTER] to select. The default is OFF.

Night Bell Monitor.

Choose whether to monitor Nightbell activity. Use the
space bar to toggle between ON and OFF, then press
[ENTER] to select. The default is OFF.

Supervised Trunk Mode.

This parameter enables the Controller to disconnect the
station to trunk connection in certain PABXs that have the
ability to recognize a reverse disconnect sent by the
Controller. Use the space bar to toggle between ON and
OFF, then press [ENTER] to select. The default is OFF.

Zone Microphone.

This parameter allows you to specify that a zone
microphone (or other audio input device) is attached to the
Attendant Access interface. When the Zone Microphone
option is enabled (ON), the controller will wait for a zone to
be selected from the microphone keypad (DTMF tone)
before it makes a page. When disabled (OFF), the
controller reverts to normal. Use the space bar to toggle
between ON and OFF, then press [ENTER] to select. The
default is OFF.

Inhibit Dial Tone Detect.

This parameter defeats the dial tone detect function in the
event that the user desires to send a tone via the telephone
interface to the page output. This feature is only applicable
in the station access mode. Use the space bar to toggle
between ON and OFF, then press [ENTER] to select. The
default is OFF.

Serial Port Bit Rate.

The bit rate of the controller's RS-232 serial port can be set
to the rate of the computer or visual display. Selections are
300, 1200, 2400, 4800, 9600, 14.2k, and 19.2k bps.
Default is 9600 bps. The bit rate may be changed at any
time, but the Controller must be reset (power off then on
again) in order to take effect. Use the space bar to toggle
between speeds, then press [ENTER] to select.




Zone/Group Parameters

Zone/group options are specific to a zone or group, and
do not apply to the system as a whole. When this option
Is selected, you are prompted to enter the 2-digit number
of the zone or group for which you are setting parameters.
Press [F1] for context-specific HELP.

For further information about zone/group configuration
options, refer to the PagePac Plus Controller Programming
and Use Guide.

1. Type Zone/Group Number.

Type the 2-digit physical zone number, from 01 to 56 (for
individual zones) or from 80 through 88 (for groups), and
press [ENTER]. Each zone or group must be programmed,
So repeat these steps for each zone or group.
If you type a zone number (01 through 56), an options
table will appear for that individual zone. Proceed with

below.

If you type group number 80 (the factory-set All-Call
group) or another group number (81 through 88), an

options table will appear for that zone group. Proceed to
below.

The following functions allow you to maneuver within the
tables.

» Use the Space Bar to toggle between options.
» Press [ENTER] to select a setting.

« Press [CTRL] plus [ENTER] to accept changes
and exit table.

The arrow keys , <up, down> move the cursor within
the table. Use the space bar to toggle between ON
and OFF or to scroll through the options for each
parameter. Then press [ENTER] to select the option.
When finished with this menu, hold down the [CTRL]
key while pressing [ENTER] to accept the parameters
and return to the Menu Bar.

13




Select OUTPUT or INPUT.

Is this zone to be an OUTPUT or an INPUT zone? If
INPUT, two levels of priority are available: INPUT(1) and
INPUT(2). Use space bar to toggle, and press [ENTER] to
select. The default Zone Type is OUTPUT.

Select OUTPUT TYPE.

For an OUTPUT zone only, select the type of output. The
default output type is AUDIO (N/O). Press space bar to
scroll through other options, Momentary, Normally Closed,
System Handshake, Toggle, Phantom, And AAReady.

Page Enable YES/NO.

For an OUTPUT zone only, select YES to enable paging
audio to this paging zone, and press [ENTER]. The default
is YES.

Music Enable YES/NO.

For an OUTPUT zone only, select YES to enable
background music to this audio zone, and press [ENTER].
The default is NO.

Talkback Enable YES/NO.

For an OUTPUT zone only, select YES to enable talkback
for this audio zone, and press [ENTER]. The default is NO.

Filew

Viewr Transferr  Options® Monitory  Help

System System parameters
HelqlV{elgeltle] | ZONe/Group parameters
Groups Sone groups

Zone Configuration

Zone 4 Features : Current New

Zone Type - [SLECHE
Output type > AUDIO (N/0O) AUDIO (N/0O)
Page enable : YES YES

Music enable : NO NO
Talk-back enable :NO NO

Night bell enable : NO NO

Pass DTMF :NO NO

Input closure tone : NONE NONE

Tone routing 10 o

Audio source : NONE NONE
Audio routing :0 0

Remote monitoring : NO NO

Press SPACE BAR bar to change entries or enter digits

—Ctrl-Enter to Accept - ESC to Abort————

Figure 4. Individual Zone Parameters Table




10.

11.

12.

13.

14.

Nightbell Enable YES/NO.

For an OUTPUT zone only, select YES to enable the
nightbell feature to be active in this zone. Then press
[ENTER]. The default is NO.

Pass DTMF YES/NO.

For an OUTPUT zone only, select YES to pass touchtone
telephone (DTMF) tones through this output zone (to
another controller). Then press [ENTER]. The default is
NO.

Select Input Closure Tone.

For an input contact closure zone, select the audio tone to
be sounded when an input is active. Use space bar to
scroll through the options: NONE, CHIME, FAST SIREN,
WARBLE SIREN, NIGHT BELL, FAST RING, STEADY
TONE, and DOORBELL. Then press [ENTER]. The
default is NONE.

Tone Routing: Enter Zone Number.

Designate an output zone to receive the tone selected in
the previous step. Type the 2-digit zone number, and press
[ENTER].

Select Audio Source.

Select the audio source for paging in this output audio
zone. Options are NONE, ATTENDANT ACCESS, and
TELEPHONE. The default is NONE. Then press [ENTER].

Audio Routing: Type Zone Number.

Type the 2-digit zone number of the zone to which the
audio is to be routed, and press [ENTER].

Remote Monitoring YES/NO.

Choose YES to select this zone for remote monitoring by
computer or display device and press [ENTER]. (The
choice of computer or display device was made under
System Parameters.) The default is NO.

Press [CTRL] plus [ENTER] to accept changes and
exit table.

Repeat these 14 steps for each individual zone. Go to [step]

to select options for a zone group.

15




File¥

View®  Configr Transfer®  Options®?  Monitorv Help
System System parameters
Zone/Group Zone/Group parameters
Groups Zone groups
Map Zone mapping
Copy Copy configuration

Group Configuration

Group 81 Features: Current New
Page enable - S5
Talk-back enable 1 NO NO
Pass DTMF : NO NO
Remote Monitoring: NO NO

TO CONFIGURE: Press SPACE BAR bar to change entries

Ctrl-Enter to Accept - ESC to Abort

Figure 5. Zone Group Parameters Table

NOTE: When a conflict
exists between an
individual zone
parameter (for example,
Page Enable NO) and a
parameter for a group
that includes the zone
(for example, group
Page Enable YES), the
group parameter will
override the individual
parameter whenever
the group is accessed.

The steps that follow are for selecting zone group
parameters.

15.

17.

18.

Page Enable YES/NO.

For a group of OUTPUT zones, select YES to enable
paging audio to all zones in this group, and press [ENTER].
The default is YES.

. Talkback Enable YES/NO.

For a group of OUTPUT zones, select YES to enable
talkback for all zones in the group, and press [ENTER].
The default is NO.

Pass DTMF YES/NO.

For a group of OUTPUT zones, select YES to pass
touchtone telephone (DTMF) tones through these output
zones (to another controller). Then press [ENTER]. The
default is NO.

Remote Monitoring YES/NO.

Choose YES to select this group for remote monitoring by
computer or display device and press [ENTER]. (The
choice of computer or display device was made under
System Parameter.) The default is NO.




Zone Groups

This option displays a table in which the user defines a

group of zones. First, you are prompted to enter a Group

Number for the group, then a table will appear in which
you select individual zones to be included in this group.
Repeat this procedure for each Zone Group.

For further information about zone grouping, refer to the
PagePac Plus Controller Programming and Use Guide.

1. Type Group Number.

Type a 2-digit number from 81 through 88, to
identify this group. Press [ENTER].

A table will display, titled Group Configuration.

Filew Vieww

03[ ]
04 ]
05[ ]
06[ ]
08[ %

Group 81 active

TO CONFIGURE:

Ctrl-Enter to Accept - ESC to Abort

Confige  Transfer¥ Options¥ Monitorv Help
System System parameters
Zone/Group | Zone/Group parameters
P Zone groups
ap Zone mapping
Copy Copy configuration
Group Configuration
09[ ] 17[ ] 25[ ] 33[ ] 41 ] 49[ ]
] 18[ | 26[ | 34 | 42[ | 50[ ]
] 19 ] 27[ | 35[ | 43[ ] 51[ ]
12[ ] 20[ ] 28[ ] 36[ ] 44[ ] 52[ ]
13[ ] 21] ] 29[ ] 37[ ] 45[ ] 53[ ]
14[ ] 22[ ] 30[ ] 38[ ] 46[ ] 54[ ]
15[ ] 23[ ] 31[ ] 39 ] 47[ ] 55[ ]
16[ ] 24[ ] 32[ ] 40[ ] 48[ ] 56[ ]

Press SPACE BAR bar to ADD/DELETE a zone

Figure 6. Group Configuration Table
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2. Select Zones.

» Keyboard: use the arrow keys to move up and
down in the current column of the table. Tab to
advance from the bottom entry in one column to
the top entry in the next. Use the space bar to
select individual zones to make up this group.
[Shift] + [Tab] move the selection backwards.

= Mouse: highlight an individual zone and press the
space bar to select. Repeat for other zones to be
included in this group.

A check mark will appear next to the zone to indicate it has
been selected.

3. Press [CTRL] + [ENTER] to accept changes and exit
table.

When finished with this table, hold down the [CTRL] key
while pressing [ENTER] to accept the group definition and
return to the Menu Bar. Repeat this procedure for the next
Zone Group.

18




Zone Mapping

Selecting Map from the Config Menu first shows a prompt
that asks you to indicate the map entry size, the number of
digits (2, 3, or 4) you wish to use for telephone dialing
extensions for paging zones.

You are also prompted to select the zone map format.
This only applies if 3 or 4 digits were selected on map
entry size.

1. Enter Map Size (number of digits) and press [Enter]

Use the space bar to cycle through the available lengths:
2, 3, or 4 digits.

If you select 2-digits, you are automatically returned to the
Menu Bar, since 2-digit numbers are the default zone
identifiers.

2. Select ISSUE1 or ISSUE2 and press [Control]+[Enter]

Use the space bar to select the issue #. This identifies the
firmware version of your unit. Review the procedure on the
[next page]to determine issue #.

File? Vieww Transfer?  Options' Monitor?  Help

System System parameters
Zone/Group | Zone/Group parameters

Groups Zone groups
ma_h Zone mapping

Zone/Group Re-mapping

01[4001 15[4014] 29[??27] 43 ????] 80[??7?7]
02[4002 30[???7?] 44?27?27 81[???7?]
03[4003 200 31[?2727] 45 ????] 82[??27]
04[4004 18?2?27 32[???7?] 46[?7?7?7 83[???7]
05[4004 19[?727?°? 33[???7? 47[???7 84[?227]
06[4005 20[??72? 34[??27?27 48[?7?7 85[??27]
07[4006 21[??72? 35[??27?7 49[?27?7 86[??27]
08[4007 22[??27 36[???7? 50[??7?? 87[??27]
09[4008 23[??72? 37[???7? 51[??27?? 88[??27]
10[4009 24[??727 38[???7? 52[222?

11[4010 25[??772 39?2?27 53[?7?7?7

12[4011 26[??2? 40[?727?7 54[??27

13[4012 27[??2? 41[?727?7 55[??727

14[4013 28[??7?27 42[?7?7?7? 56[??7??

TO CONFIGURE: TAB to field and enter digits

Ctrl-Enter to Accept - ESC to Abort

Figure 7. Zone Map Configuration Table

19




If you selected 3-digit or 4-digit mapping, the program
opens up a table called Zone/Group Re-Mapping.

3. Type Zone Alias Numbers.

Designate telephone dialing extensions for the individual
zones 01 through 56 and zone groups 80 through 88.

= From the Keyboard: use the arrow keys to move
up and down the current column of the table.
Press Tab key to advance from the bottom of one

column to the top of the next. [Shift] + Tab to
move backwards.

Highlight field, then type in the Alias number
(telephone dialing extension of each zone).
Press [ENTER].

= Using the Mouse: highlight the zone, then type
the zone number and press [ENTER].

NOTE: Pressing All Alias numbers must have the same length, either 2, 3,
[ENTER] without typing or 4 digits.

'rgsirl‘t?:'r?z rz':?;b(%r) 4. Press [CTRL] + [ENTER] to accept changes and exit
Alias number. [Shift] + table.

E:fﬂwn;%is he ST 16 find out which Zone Map Format (Issue#) is in use:

1. Select Receive from the Transfer menu to transfer the
: current (default) configuration from the PagePac Plus
NOTE: This procedure
only needs to be done if Controller to the computer.

Zone Mapping is used, 2. When transfer is complete, go to the View menu and

and must be done select Information.
before programming.

Make sure null-modem 3. If the number of installed zones and software
cable is connected from checksum fields are blank, the Zone Map should be
the PC to the Controller. in ISSUE1 format.

If these fields contain values, then the Zone Map
should be in ISSUE2 format.
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Copy

The COPY option allows you to copy the configuration of
one already-configured zone, to another zone (or series of
zones), without having to configure them individually.

1. Select COPY.

A table will appear in which you will indicate the zone
you wish to copy from (the Source), and the zone(s)
you wish to copy to (the Destination).

2. Enter source zone number (01 through 56).

3. Enter the beginning and end of the range of
destination zone numbers.

For example, 34 through 34 indicates the single
destination zone 34, but 34 through 39 indicates six
destination zones.

4. Press [CTRL] plus [ENTER] to accept (to activate the
copy function).

Filew Vieww Configr Transfer® Options¥ Monitor? Help

System System parameters
Zone/Group |Zone/Group parameters
Groups Zone groups

Map Zone mapping

Copy configuration

Copy Configuration

Enter Configuration Source -

Enter First Zone In Range
Enter Last Zone in Range 34

Ctrl-Enter to Accept — ESC to Abort

Figure 8. Copy Option
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Transfer Menu

Connect

The Transfer menu opens an option box in which you may
choose to Send your current configuration to the
Controller, or Receive the Controller’s current operating
configuration to the User Interface program. You may also
choose to connect directly to your PC’s serial port, to
control a modem.

Send

Select Connect to communicate transparently with the
serial port, facilitating operation with a modem to configure
the Controller remotely.

Recealve

Select Send to copy the currently loaded configuration to
the Controller (The transfer takes about 12 seconds). This
will then become the effective configuration of the paging
system. It will remain in the Controller's memory until
replaced by another Send action, or until modified by
touchtone telephone keypad programming changes.

Select Send and press [ENTER].

The Receive option copies the Controller's current
configuration into the computer. This option permits the
user to capture (copy and view) any changes that may
have been made to the paging system configuration by
means of the touchtone telephone keypad (DTMF)
interface. Once the configuration has been received, you
may view it, make changes to it (using the Config menu),
save it to disk, and send your modified configuration back
to the Controller.




Select Receive.

Type the first letter (R) or use the arrow key or mouse to
highlight Receive, then press [ENTER)].

File¥ Vieww Confige Transfer? Options? Monitor¥ Help

Connect | Connect to serial port
Send Send_configuration to controller
Receive | Receive configuration from controller

——Send Configuration
Configuration being Sent: ] % Done

Hit any key to Abort

Figure 9. Transfer Menu, Send Option

Options Menu

NOTE: The Controller
must be reset (power off
then on again) in order
to take effect.

The Options menu prompts the user to define the serial
COM port of the computer or visual display that is used to
interface with the PagePac Plus Controller.

1. Select COM Port Number.

Press space bar to toggle between the options (COM1,
COM2, COM3, and COM4). Press [ENTER] to assign. The
default is COML1.

Select Bit Rate.

Press space bar to toggle between the options (300, 1200,
2400, 4800, 9600, 14.4k, and 19.2k bps). Press [CNTL]
[ENTER] to accept changes and exit.

File» Vieww Configr Transferv Monitor?  Help

‘ ‘ Serial port options

Port options

Bit Rate: 9600
trl-Enter to Accept - ESC to Abort

Figure 10. Options Menu, Port Options
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Monitor Menu

Press [F1] for
context-specific HELP

The Monitor Menu permits the user to activate the
automatic monitor function of the PagePac Plus Controller
(connected to the PC). It also permits the designation of a
computer file for recording all monitor activity (the Log File
option).

For further information about PC monitoring and logging of
paging activity, refer to the PagePac Plus Controller
Programming and Use Guide.

1. Select Start Monitor.

2. Highlight the START MONITOR option and press
[ENTER].
The screen will go blank except for the header “Paging
Activity Monitor.” Leave this screen active, and the PC

turned on, to enable the monitor function of the PagePac
Plus Controller.

The screen will display the activity of the paging system in
real time. Each message consists of a reference number,
a description, and a time stamp.

3. Press [ESC] to exit back to the Menu Bar.

If you have defined a log file, press [F2] (toggle) to
activate (open) or deactivate (close) the log file.




4. Select Log File
You will be prompted to name a Log File, which is a

diskette file where the paging messages will be recorded.

Enter a file name (up to 8 characters).

Press [F1] for
context-specific HELP. 5. Press [ESC] to Abort

A default log file will be activated, and return to the
Menu Bar.
To Activate the Log File
Select Start Monitor from the Monitor menu and press
[F2]
To Log File to a Printer/port
Type afile name of PRN or LPTn, and press [Enter]

For example, LPT1, LPT2, is the number of the parallel port

to which your printer is connected.

Filew Vieww Configv Transfery options? Help

Start Monitor Monitor Mode

Log File Define log file

Define Log File
Enter File Name Prefix (8 chars max): || IEGzGG

ESC to Abort

Figure 11. Log File Option
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Help Menu

The Help menu gives a brief description of the
context-sensitive on-line help function, which is activated

by pressing the [F1] key at any time during the PPPLUS
program.

Filev View? Config®¥ Transfer®

OptionsY Monitore

 ————
elp system Is context sensitive.

By pressing the F1 key anywhere in the
menu system, a help screen ‘pertaining
to the ‘level you are at will appear.

Press any key to continue

Figure 12. Help Menu
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